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WEEKS until the 
General Election 

Newspapers 
are ready to 
talk to you 
about print 
and web 

advertising. 

Call your local newspaper or 

Oklahoma Press Service at 

(405) 499-0020 for help

with your ad placement.

It’s football season in 
Oklahoma and newspa-
pers are scurrying to cover 
games.

Whether it’s pee wee, 
junior high, high school or 
collegiate games, football 
coverage increases content 
– and often revenue.

It’s a team effort for 
the newspaper staff. While 
there are some new tricks 
to covering ball games, 
such as posting live scores 
on Facebook and Twitter, 
time-honored conventional 
coverage still rules in the 
newspaper.

Sales promotions, spe-
cial sections, player pro-
files, features and contests 
are all a part of the cover-
age. And there’s something 
for every size newspaper 
– from the largest daily to 
the smallest weekly – that 
covers a team.

To engage readers, the 
Vian Tenkiller News has 
found success in its “Faces 
in the Crowd” football con-
test.

“We take a photo of 
the crowd in the stands at 
every home game,” said 
Amy Remer, editor of the 
News. “In the following 
issue, we run the photo 
with a ‘selected’ person’s 
face circled. The person 
selected is then asked to 
come by the office to claim 
their prize voucher.”

Prizes are donated by 
local merchants and consist 

of items such as gift cer-
tificates, free haircuts, free 
mascot T-shirts, dinner for 
two before the game, etc., 
said Remer. The person or 
business that sponsors the 
week’s photo pays $40 for 
the photo placement.

The Newcastle Pacer 
shows its spirit by offer-
ing readers a chance to 
win $50 in the Football 
Pick’Em Contest. Readers 
select winners in 10 games, 

including the four teams in 
the Pacer’s coverage area. 

“OU and OSU are 
always our tie breakers,” 
said Kimberly Noe, the 
Pacer’s advertising direc-
tor. “It’s a huge readership 
draw. We get anywhere 
from 50 to 75 entries in the 
office, plus what feels like 
thousands from our online 
form.”

An additional $25 can 
be won by finding a hidden 

mini football in one of the 
newspaper’s ads.

The Pacer also engages 
readers with its Football 
Picks of the Week. This 
year, three Pacer staff 
members, the police and 
fire chiefs, and one weekly 
guest from the community 
are putting their predic-
tions in print.

“I get more comments 
from people I don’t know 
when they recognize me 
from the staff football 

picks,” said Noe. “People 
love it.”

Advertisers can find a 
good deal by becoming 
members of the Weather-
ford Daily News’ Sports 
Page Club. The $750 mem-
bership fee, a $2,505 value, 
includes one free full page 
ad; five player of the week 
sponsorships; a minimum 
of 10 booster pages pro-
moting various sporting 
events year round; ads in 
three sports tabs; exclusive 
sports page ads a minimum 
of 10 times per year; and a 
10-week football contest.

Publisher Phillip Reid 
offers a variety of contests 
and promotions during the 
sports season including a 
special Parents Day Tab for 
students at Southwestern 
Oklahoma State Univer-
sity. The event brings hun-
dreds of people into local 
businesses, said Reid.

Player of the Week is 
the most popular contest 
at The Purcell Register, 
said Advertising Director 
Vickie Foraker.

The contest runs for 10 
weeks, beginning the week 
after the first high school 
game, she said.

The coach for each of 
the four schools The Reg-
ister covers nominates a 
player for offense, defense 
and offensive line and 
defensive line. Based on 

ARE YOU READY FOR SOME FOOTBALL?

The Oklahoman used the theme “It’s better to receive” as the inspiration for the cover of 
special sections featuring the University of Oklahoma and Oklahoma State University.

Continued on Page 3
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Frustrated by what it called “harass-
ment and the inability to carry through 
with municipal business,” Boynton admin-
istrators shuttered the city hall for nearly 
a week. 

The “harassment” stems from investi-
gations into such alleged conduct as open 
meeting violations, open record violations, 
nepotism and other issues. 

Public meetings were adjourned in 
August when deputies showed up with 
tape recorders, Muskogee County officials 
have said.

Muskogee County District Attorney 
Larry Moore said his office is having 
trouble receiving public records from the 
town.

“We have requested certain council 
meeting minutes and understand the mayor 
took those meeting records, that some have 
been returned and others have been lost or 
may no longer exist,” Moore said.

Moore said that his office was look-
ing into the matter and, along with the 
Muskogee County Sheriff’s Department, 
is investigating the other charges.

Your Oklahoma Press Association, just like every newspaper in the state, faces a new 
set of challenges as we move forward. 

Those challenges include numerous battles at the State Capitol from lobbying groups 
that want to move legal notices from the public eye of newspapers to places you have to 
hunt to find on the Internet, to wanting to raise revenue by taxing advertising and circula-
tion. 

Because we have one of the best in Mark Thomas – and newspapers that are active 
and contact their elected officials – we were able to defend and protect the peoples’ right 
to know. But to do so there were many 16-hour days spent trying to head off something 
that might have been slipped in long after the sun sat at 23rd and Lincoln. And the fight 
continues all through the summer and fall – it’s a year-round battle anymore.

The good news is we won the battles … at least for now.
During some of those battles, lobbyists from the Oklahoma Municipal League, along 

with other taxpayer funded organizations, outnumbered the OPA’s lone advocate 30 to 
1. The City of Norman’s dues alone to the Oklahoma Municipal League are $75,000 
per year – nearly equal the total dues paid to the OPA from all its member newspapers 
combined.

SO HOW DOES THE OPA FUND NEWSPAPER LOBBYING EFFORTS, our computer and postal 
road warriors, educational seminars and training sessions, along with the countless other 
services provided? It is by the commission we receive by selling advertising, earning 
money from the Clipping Service and a very small portion from the member dues.

It is common to hear publishers complain about the 30 percent commission charged 
for advertising coming through the Oklahoma Press Service. Of that amount, the OPS 
typically receives 15 percent and the placing advertising agency receives the other 15 
percent, or at least that is the way it used to be.

The solution I often hear is if OPA needs more money then they should go sell more 
ads. If it were that easy I should be able to double the revenue of my newspaper anytime 
I want. But just like in my newspaper, dreams and reality are miles apart.

Now, because so many newspapers offer space directly to advertising agencies at a 
price lower than the net rate they would earn if the ad were placed through the OPS, ad 
agencies are bypassing the OPS and going directly to newspapers. Our biggest challenge 
may be that today’s technology allows advertisers to bypass OPS. 

Another item that impairs OPS is the scores of newspapers each month that, for what-
ever reason, fail to run ads placed by the Press Service. Can you imagine trying to resell 
a customer on the importance of being in the newspaper when newspapers don’t find it 
important enough to publish ads that come with guaranteed payment? 

And then there are things, such as the Race for Space, that OPS sells solely for the 
benefit of your newspaper where the Press Service did not make one cent for all of the 
work that was put in. Yes, it was good for the member newspapers, but it didn’t put any 
money in the coffers for lobbying and other OPA member services.

IT IS EASY TO WANT ALL OF THE BENEFITS the OPA provides as long as someone else (OPS) 
is paying the bill. But those days may be gone.

As one of our board members said, most newspapers pay far less in OPA dues than 
they do to be members of the Lions, Rotary or Kiwanis club, yet OPA members get so 
much more in return for their investment. 

Your OPA board of directors is working hard to come up with a new dues structure that 
will keep the Oklahoma Press Association viable for many years to come. And when the 
OPA is viable, so are newspapers across the state.

Our goal is to make sure that everyone, from the legislator to the advertiser, under-
stands newspapers are the number one source for accurate, reliable information. 

START THE PRESS
OPA President’s Column

By ROD SERFOSS 
Clinton Daily News Publisher

Photographing marked ballots against the law

City of Boynton under investigation

Randy L. Goodman has applied for an 
associate membership in the Oklahoma 
Press Association.

Goodman practices law in eastern 
Oklahoma County. Prior to that, he 
worked for Richard Hefton’s Eastern 
Oklahoma County group of newspapers. 

The Oklahoma Press Association 

Board of Directors will vote on the 
application at their next meeting on Oct. 
14, 2010. 

Any current member wishing to object 
to Goodman’s application must do so in 
writing to the OPA at 3601 N. Lincoln 
Blvd., Oklahoma City, OK 73105-5499, 
by Oct. 4, 2010.

OPA receives associate membership application

Kandra Wells has taken up the post of 
editor at the McAlester News-Capital. 

Wells said one of her first goals is to 
hire more people.

“We’ve got a great team and we’re 
looking to hire more journalists to add to 
the team,” she said. “We’ve been working 
short-handed since November.”

Wells started her journalism career in 
1982, writing obituaries and assisting other 

reporters for the Joplin Globe while she 
attended college. In 1991, she began work-
ing at the News-Capital as a staff writer 
and stayed for several years. 

She returned to the News-Capital in 
2008 after working as news editor for the 
Alamogordo Daily News in New Mexico 
and editor of the Antlers American. 

Wells succeeds long-time editor Matt 
Lane.

If you’re planning to send a photog-
rapher out to snap a photo of someone 
voting, don’t forget that there are rules 
the photographer must follow.

An Oklahoma statute (26 O.S. 7-112) 
states that “at no time during the hours 
of voting shall any person, other than 
the election officials and other persons 
authorized by law, be allowed inside the 
election enclosure except for one regis-
tered voter in each voting booth and one 
other registered voter for each voting 
booth.”

However, the statute does allow a 

news reporter or photographer inside 
the election enclosure for a period not to 
exceed five minutes.

 “Such reporter or photographer shall 
not interfere with voters or election offi-
cials and shall neither observe any indi-
vidual voter while the voter marks a 
ballot nor photograph any voter who is 
marking a ballot.”

Make sure your photographers under-
stand that they are not allowed to take 
photos of a voter marking a ballot. It’s 
the law.

McAlester News-Capital names new managing editor
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the player’s stats, a winner is chosen in 
each category. 

Winners are featured in a full-page ad, 
along with a list of sponsors. In addition 
to the ad in the paper, T-shirts are printed 
with Heart of Oklahoma Player of the 
Week with sponsors on the back of the 
shirts.

“We’ve been doing this for 18 or 19 
years and it has remained popular with 
the coaches and players and is a very easy 
sell,” said Foraker.

At the end of the season, an award 
for player of the year for each position is 
presented. 

Winners receive a plaque at a basketball 
game or at the awards assembly.

The Ardmoreite publishes an annual 
tab plus a weekly schedule of its four core 
teams, which includes an online compo-
nent. 

Advertising Director Lisa Wilkinson 
said a new addition to its coverage this 
year is a football poster.

From contests to promotions, Okla-

homa newspapers are keeping readers 
informed about local sports. Eye-catching 
page design is showing up on front pages 
and special sections. 

Using the theme “It’s better to receive,” 
Matt Clayton’s compelling design was 
featured on the covers of The Oklaho-
man’s OU, OSU and high school football 
sections. 

When it comes to getting ready for 
some football, nobody does it better than 
community newspapers. 

Oklahoma newspapers promote football to readers and advertisers. At left, The Purcell Register and 
Weatherford Daily News offer discounts to advertisers while the Vian Tenkiller News engages readers 
with its ‘Faces in the Crowd’ promotion. Above, The Ardmoreite shows team spirit with its full-color 
poster. The Newcastle Pacer’s Football Pick’Em is a favorite of the community. 

Continued from Page 1

Oklahoma newspapers score additional revenue during football season 
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OPA CALENDAR OF EVENTS
Complete Listing of Events at

www.OkPress.com
MON, SEPT. 27 
CONTEST ENTRY DEADLINE

Entries must be postmarked by Monday, Sept. 
27 for the Better Newspaper Contest, Website 
Contest, Print Quality Contest and ONF 
Outdoor Writer of the Year Award. Rules and 
entry forms at www.okpress.com/awards.

SEPT. 30 - OCT. 3 
NNA CONVENTION 
IN OMAHA, NEBRASKA

Celebrate 125 years of NNA at the annual 
convention. Visit nnaweb.org for more info.

FEB. 3-5, 2011 – MIDWEST CITY 
OPA MID-WINTER CONVENTION

The annual convention will once again be held 
at the Sheraton & Reed Center in Midwest City.

For more information on upcoming events, visit the 
website as noted in the calendar, go to the OPA website at 
www.OkPress.com or contact Member Services Director 

Lisa Potts at (405) 499-0026, 1-888-815-2672 or 
e-mail LPotts@okpress.com.

OPA/OPS boards discuss the future at July meeting
The Oklahoma Press Association and 

Oklahoma Press Service Boards of Direc-
tors met July 29, 2010, in Oklahoma City.

Officers attending were President 
Rod Serfoss, Clinton Daily News; Vice 
President Rusty Ferguson, The Cleveland 
American; and Treasurer Barb Walter, The 
Hennessey Clipper. Directors attending 
were Past President Gloria Trotter, The 
Countywide & Sun; Jeff Shultz, Garvin 
County News Star; Jeff Funk, Enid News 
& Eagle; Robby Trammell, The Okla-
homan; Dayva Spitzer, Sayre Record & 
Beckham County Democrat; and Brian 
Blansett, Shawnee News-Star. Staff attend-
ing was OPA Executive Vice President 
Mark Thomas; Member Services Director 
Lisa Potts and Attorney Michael Minnis. 
Jeff Mayo, Sequoyah County Times, was 
absent.

Serfoss asked board members to review 
the minutes of the June 5, 2010, meeting. 

Reading of the minutes was suspended and 
the minutes were approved as presented.

After reviewing financial information, 
the board acknowledged receipt of the OPA 
and LSP financial statements, consolidated 
summary and investment reports.

The sustaining membership applica-
tion of Athlon Media was considered and 
unanimously approved by the board at the 
meeting. 

Thomas reported that the business 
membership of The Weekly Leader in 
Tahlequah has been suspended due to non-
payment of membership dues for the 2009-
10 year. The membership will terminate if 
payment is not received by the date of the 
next board meeting.

The board also approved OPA/S and 
LSP contracts and rates for the legal ser-
vices of Michael Minnis of Doerner, Saun-
ders, Daniel and Anderson for fiscal year 
2010-11, at no increase from the prior 
year.

The board discussed the OPA member-
ship dues structure and several options to 
help OPA and OPS continue to provide 

services and meet the challenges of the 
future.

After careful consideration, the board 
unanimously approved charging a 25-cent 
per page service fee, effective Jan. 1, 2011, 
to all newspapers not uploading pages to 
OPEN. 

The board also approved eliminating 
the OCAN/2x2 discount within two years, 
with a 25 percent discount in 2010-11 and 
zero percent discount in 2011-12.

Other options discussed included 
changes to the membership dues struc-
ture, renting space in the OPA building to 
another entity and possible changes to the 
computer consultant and postal consultant 
programs.

At the OPS board meeting, minutes of 
the June 5, 2010, meeting were approved 
and receipt of the OPS financial statement 
was acknowledged.

Following the management review, Ser-
foss asked Thomas to develop a newsletter 
for the general membership. Serfoss also 
said the board was pleased with the early 
results of the Race for Space program.

ROBERT R. ‘BOB’ STACY, who worked for 
the Oklahoma Press Association for many 
years, died Aug. 19, 2010. He was 61.

Stacy was born Nov. 22, 1948. He 
graduated from Lake Michigan College in 
Benton Harbor in 1968 with an associate 
degree in marketing and retailing.

His first job in the newspaper business 
was as classified display salesman at the 
Palladium Publishing Company in Benton 
Harbor. Stacy left Michigan in 1971 to 
accept a position with Sentinel Suburban 
Newspapers in Denver, Colo. 

In 1972, he moved to Edmond, Okla., 
and was named advertising director of the 
Edmond Sun & Booster.

Stacy was named assistant manager of 

the Oklahoma Press Association and vice 
president of Oklahoma Press Service in 
1974. He held those two positions for more 
than 20 years. After leaving OPA, Stacy 
worked for Pro Graphics, Inc. and the 
Oklahoma Department of Commerce.

Always active in the advertising com-
munity, Stacy served as president of the 
Oklahoma City Advertising Club and as 
governor of the 10th District American 
Advertising Federation. He was named 
Advertising Person of the Year by the OKC 
Ad Club and received the distinguished 
silver medal award from the American 
Advertising Federation.

Stacy was an avid golfer and enjoyed 
sailing.

DEATHS

NEWSPAPER & PUBLICATION BINDING
Before you have your next issue bound, give us a call. We offer exceptional quality, 
competitive pricing and fast turnaround times. With three generations of experi-
ence, we have the knowledge and skill to get your job done. Other services 
include Bible binding and restoration, embossing and much more.

ACE BOOKBINDING CO.

E-mail: AL@AceBookbinding.com • www.AceBookBinding.com

825 N. Classen Blvd., Oklahoma City, OK 73106
(405) 525-8888 or Toll-Free at 1-800-525-8896

Commercial Printing

The Marlow Review
316 W Main St

PO Box 153
Marlow, OK 73055

580-658-6657
john@marlowreview.com

www.marlowreview.com/commprinting

Contact us for your commercial
printing needs.

PROVIDING
LETTERHEAD
ENVELOPES

LABELS
MULTI-PART FORMS

NCR FORMS
BUSINESS CARDS

BOOKLETS
BROCHURES

4-COLOR PRINTING
NUMBERING

PERFORATING
HOLE PUNCHING

The Marlow Review
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www.nationalmediasales.com

EDWARD M. ANDERSON
P.O. Box 2001

BRANSON, MO  65616
(417) 336-3457

brokered1@aol.com

Newspaper Brokers   

Appraisers        

Consultants
THOMAS C. BOLITHO

 P.O. BOX 849
ADA, OK 74821
(580) 421-9600

bolitho@bolitho.com

We have many years experience in 
the community newspaper market

LEGAL ADVICE
is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing 
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 

LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

Last month, The Publisher focused on 
ways newspapers could use social net-
works such as Facebook to reach readers, 
engage in discussions and promote your 
product. This month, I thought I would 
point out a few of my favorite things you 
can do with a newspaper that you can’t do 
with a website or computer. Here we go.

START A FIRE – Wadded-up newspaper 
is the traditional beginning for bonfires, 
fireplaces and camp grills. 

Computers, not so much – they’re hard 
to light and the smoke they produce will 
make you ill, if not downright kill you. 
However, if you feel compelled, you could 
start a contentious argument in an online 
forum or other social network, referred to 
as a “flame war.”

SWAT YOUR DOG – If your guilty pup sees 
you coming down the hall with a rolled 
newspaper, it’s a good bet he’s going to get 
walloped and he’ll probably bolt. 

Chasing him with a laptop is a bit less 
threatening. Simple as he is, your dog 
knows you’re not going to beat him with 
a thousand dollar machine for piddling on 
the carpet.

BECOME A LOCAL CELEBRITY – “My picture’s 
in the newspaper!”, people say with pride. 
There it is, printed in black and white, for 
good or bad, your 15 minutes of fame just 
started. Your friends are impressed. 

Ninety-nine times out of a hundred, 
“My picture’s on the Web,” is met with 
“What’s your point?”

CLEAN YOUR WINDOWS – The combination 
of glass cleaner and newspaper has 
long been the quintessential method of 
producing spotless windows. 

Attempting to wipe down your sliding 
glass door with a website can be frustrat-
ing, time consuming and ultimately futile. 
Oh, and hyperlinks leave streaks.

MAKE A HAT – Newspaper hats are the 
stuff of imagination – the birthing point 
of legends. They’re especially appropriate 
in the month of September, since the 19th 
is International Talk Like a Pirate Day – 
arrrgh. 

Walking around with a computer on 
your head is just silly and uncomfortable, 
unless you’re some sort of west coast per-
formance artist. Come to think of it, it’s 
still just silly and uncomfortable.

CREATE PAPER MACHE – Finally, almost 
every childhood included at least one 
experience with paper mache. Nearly 
anything can be constructed from this 
wondrous mixture of shredded newspaper, 
flour and water – except ashtrays... just 
don’t do it. Add a little tempura paint and 
you’ve got art!

Water + flour + laptop = doorstop.

Seriously, though, there are certain 
things you can do with a newspaper that 
you can’t with a website or computer.
• Share your newspaper with someone at 

the barber shop or leave it at the cafe.

• You can buy one on the sidewalk or at 
the local market. 

• You can scrapbook newspaper clip-
pings. It’s not the same if you simply 
print an article about little Jimmy’s 
touchdown.

• Newspapers are ultimately portable – 
you can set it down and walk off with-
out it; replacement cost is a dollar or 
less, not a grand. 

• You can read without worry. There are 
no pop-up ads in your sports section. 
And when was the last time you fretted 
about a virus in your newspaper?
This, too: generally speaking, newspa-

pers are run and staffed by professionals 
who interview sources, research actual 
documents and check their facts before 
publishing. Newspapers put feet on the 
ground to gather the news and bring it to 
the community. Newspapers have staying 
power.

Most companies in this age won’t 
devote the resources or manpower to bring 
that much professionalism and trust to 
an online-only publication. There are, of 
course, exceptions but newspapers have 
always been the rule.

Consider this: when users of websites, 
blogs, forums or chats who take the time to 
check their facts and look for verification 
before running their virtual mouths, they 
look to newspapers. It’s a source you can 
count on.

When the rubber meets the road, that’s 
what you can do with a newspaper that you 
can’t do with a website or PC.

That InterWeb Thing
by KEITH BURGIN, OPA STAFF

Yep, you can do that with a newspaper

Your 2010 Statement of Ownership 
(PS Form 3526) is to be presented 
to your postmaster on Friday, Oct. 1, 
2010. 

Remember to complete all items, 
including No. 16 (Publication of State-
ment of Ownership), and No. 17, sign-
ing and dating the form as instructed.

 NOTE: Item 14 in the first column 
calls for averages for the period of Oct. 
1, 2009, through Sept. 30, 2010. The 
second column is information from the 
most recent issue on or before Sept. 
30. 

Daily Publications are to publish 
their Statement of Ownership or fac-
simile in an issue no later than Oct. 10. 
Weeklies are to publish in any issue in 
the month of October. 

 When you print the Statement of 
Ownership, provide your postmaster 
with a copy of the issue containing 
the statement. Write the page number 
where the Statement of Ownership is 
located on the front page. 

RATE INCREASE? It’s possible that by 
the October issue of The Oklahoma 
Publisher we’ll have results of the 
rate increase requested by the US 
Postal Service. The Postal Regulatory 
Commission is scheduled to vote on 
Oct. 4. Keep your fingers crossed!

Postal Notes
by BILL NEWELL, OPA POSTAL CONSULTANT

Don’t forget to file 
ownership statements

Dave Ruthenberg, copy editor and col-
umnist for the Enid News & Eagle, has 
been named sports editor. 

A 15-year sports veteran, Ruthenberg 
has worked at the News & Eagle since 

2008. Previously, he was a beat writer cov-
ering Mid-America Conference sports for 
USAToday.com, Yahoo!Sports and CBS 
Sportsline.

Enid News & Eagle names new sports editor
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Alvin Morris of the Boston Pool Rough Riders met his match with a spotted bull that appeared 
ready to trample the photographer along with everyone else in his path.

Photo by LOUISE RED CORN, The Bigheart Times, Published July 22, 2010

JULY 2010 DAILY WINNER: 

ED BLOCHOWIAK
Shawnee News-Star

JULY 2010 WEEKLY WINNER: 

LOUISE RED CORN
The Bigheart Times 

WINNERS OF THE MONTHLY OGE PHOTO CONTEST WIN $100, 
A CERTIFICATE AND RECOGNITION IN THE OKLAHOMA PUBLISHER!

To review complete contest rules and see all winning photos, 
visit www.OkPress.com/OGE-photo-contest

THE OGE 
PHOTO

CONTEST

Ben Tannehill of Monroe, La., does his best to hang on during bull riding competition at the 
International Finals Youth Rodeo in Shawnee.

Photo by ED BLOCHOWIAK, Shawnee News-Star, Published July 17, 2010
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THANK 
YOU

to the following individuals and 
organizations for their recent 
donations to the Oklahoma 

Newspaper Foundation:

In memory of 
Lawrence Gibbs: 

ANDY & KAREN RIEGER

A donation to the Oklahoma 
Newspaper Foundation will 
support its efforts to improve the 
state’s newspaper industry 
and quality of journalism. 

ONF’s programs include training 
and education for professional 
journalists, scholarship and 
internship programs for journalism 
students, and Newspaper in 
Education efforts. 

ONF relies on donations and 
memorial contributions to fund 
these programs. 

If you would like to make a 
donation, please send a check to: 

OKLAHOMA 
NEWSPAPER 
FOUNDATION

3601 N. Lincoln Blvd.
Oklahoma City, OK 73105

Mike Boettcher is in Afghanistan again, 
embedded with the 101st Airborne, and 
this time he’s taking his OU students into 
combat with him – via technology. 

Boettcher, an award winning journal-
ist and freelance combat correspondent, 
is hoping his students will bring a fresh, 
youthful perspective and a sense of urgen-
cy to war coverage he believes has slipped 
from the younger generation’s radar. He 
and colleague John Schmeltzer are work-
ing on what he calls “a project like no 
other in the world.”

Students from the Gaylord College of 
Journalism and Mass Communications at 
the University of Oklahoma, along with 
ABC News, recently embarked on a jour-
ney that breaks new ground in both aca-
demia and real-world news coverage. By 
marrying the resources of all involved, the 
public will be allowed a peek inside the 
lives of Afghans, American soldiers and 
the soldiers’ families.

Boettcher, a visiting professor at OU, 
will be embedded for one year during 
which he will send multi-media content to 
his advanced journalism class. The class, 
meanwhile, will contact and follow the 
soldiers’ families for the semester. Stu-
dents will process content for the Web and 
create an online experience for viewers – 
coverage Boettcher hopes will focus on the 
human side of the war.

“You’re going to take that material and 
make what will be the premiere website 
in the world for coverage of the war in 
Afghanistan,” Boettcher told his students. 

“I promise you that. It’s going to be an 
amazing experience.”

The coverage will also be filed with 
ABCNews.com, World News, Good Morn-
ing America, Nightline and ABC affiliates 
in Oklahoma and Tennessee (the 101st 
Airborne is based in Nashville). The new 
site will include blogs, podcasts, video and 
slideshows.

For students, it’s an unique opportunity 
to work directly with Boettcher and his son 
Carlos and submit their work to national 

media organizations using the technol-
ogy they’ll employ in the workforce. The 
project is funded through a grant from the 
Sarkeys Foundation of Norman.

The intention is to tell the stories of 
those fighting this war, said Boettcher. 
He’s counting heavily on Schmeltzer and 
his student crew to pull it off.

This is the Boettcher father-and-son 
team’s second trip to Afghanistan – the 
first was in 2008. This time, they have 
company.

OU students working with award-winning journalist

Mike Boettcher, a visiting professor at the University of Oklahoma, is once again in 
Afhganistan covering the war – with the help of students from OU’s Gaylord College of 
Journalism and Mass Communications.

The First Amendment Congress is 
scheduled for Nov. 10, 2010, at Constitu-
tion Hall on the campus of the University 
of Central Oklahoma in Edmond.

The day is designed for high school stu-
dents, educators, parents and others inter-
ested in helping young people understand 
the First Amendment.

The 12th Annual First Amendment 
Congress, sponsored by FOI Oklahoma, 
Inc., will explore the increasing lack of 
civility in our political and civil discourse 
and ask whether it threatens our larger val-
ues and freedoms as Americans.

Featured speakers include Dr. Joey 
Senat from Oklahoma State University 
who will use examples from Oklahoma 
and elsewhere to discuss whether we have 

a First Amendment right to be offensive in 
our speech. 

Following lunch, sponsored by the 
Oklahoma Newspaper Foundation, edu-
cational consultant and former social stud-
ies teacher Rita Geiger will present real 
life examples of speech that courts have 
declared protected speech and unprotected 
speech.

Registration, which includes lunch and 
refreshments, is $15 for individuals. Spe-
cial group pricing is available for student 
and teachers.

The deadline for registration is Friday, 
Nov. 5. 

For more information or to download 
a registration form, go to www.odl.state.
ok.us/fyi/foi/index.htm.

November 10 date of First Amendment Congress
It’s never too early to start planning 

so go ahead and mark your calendar for 
the 2011 OKC Gridiron Club show.

This year’s performance will once 
again be held at Lyric Theater in the 
historic Plaza District. Performances 
are Feb. 23, 25 and 26. 

While the Gridiron likes to poke fun 
at politicians, public policy and current 
events in the annual show, its main 
focus is to fund scholarships for Okla-
homa journalism students. So why not 
make a tax-deductible donation to the 
Gridiron Foundation?

Tickets to the Gridiron can be pur-
chased online at www.okcgridiron.org, 
by phone at (866) 966-1777 or at any 
metro area Party Galaxy store.

Get Gridiron tickets early  
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By MICHAEL MINNIS, OPA ATTORNEY
The ongoing effort by 

public employees to prevent 
the public from obtaining 
access to public employee 
personal identifiers, such as 
birth dates and employee 

identification numbers, briefly threatened 
to expand into a “prior restraint” action. 

One of the plaintiffs asked the Court 
to enjoin the newspaper from publish-
ing information it had long ago obtained 
from public records. Although the plain-
tiff later withdrew this motion, it raised 
the specter of “prior restraint,” a phrase 
with ominous First Amendment over-
tones.

A recent District of Columbia court, 
looking at a somewhat similar situation, 
issued a prior restraint order. In this case, 
the judge restrained a newspaper from 
publishing truthful information lawfully 
obtained from the court clerk’s office 

because the clerk’s office erred in releas-
ing sealed information.

After the newspaper filed an emer-
gency appeal and the party seeking the 
prior restraint withdrew its motion, the 
judge lifted the prior restraint. Even so, 
the judge said, “If I am throwing 80 years 
of First Amendment jurisprudence on its 
head, so be it.”

The judicial arrogance displayed runs 
counter to the case law, which is that 
“the fundamental question … is whether 
the ‘publication … threaten[s] an interest 
more fundamental than the First Amend-
ment itself’ … If it does not, the prior 
restraint is unconstitutional.” 

The Supreme Court has never upheld 
a prior restraint. The case law is that 
“the accidental release of confidential 
information to the public does not permit 
a second mistake, this time of constitu-
tional magnitude of imposing liability for 
publication of the information.”

Prior restraint could muzzle the press

Lend us your errs.

Toiling in the fields of print
journalism is too often an
unsung task. As much as the

readers may enjoy the newspapers,
they can hardly be expected to
appreciate the herculean effort and
prodigious skill which are regularly
summoned by the men and women
who bring them the news.

That’s why we in the industry
take it upon ourselves to recognize
notable achievements through various
sorts of awards.

One such award is OPA’s annual
Grand Blooper Award, given each
year to a newspaper for achievement
in the Blooper medium above and
beyond the call of duty; and for
general endeavors to foster Blooper
technology in Oklahoma.

In order to ensure that the Grand
Blooper Award goes to someone truly

deserving, we beg your cooperation by
sending us the year’s best bloopers.
They can be your own, or those of
someone you admire. Send a tearsheet
or photocopy to:

Grand Blooper Award
c/o OPA
3601 N. Lincoln Blvd.
Oklahoma City, OK 73105-5499
Fax (405) 524-2201.

Thank you for helping us to assign
credit where it’s doo.

Signing up for the United States Postal 
Service’s Business Customer Gateway can 
be intimidating, to say the least.

To assist you, the Postal Service cre-
ated a 107-page presentation to lead you 
through it. That’s not a typo – that’s one 
hundred and seven pages. To be fair, 
there’s a huge umbrella of services in 
the Gateway, many that you’ll never use, 
which are covered in the presentation.

Although it isn’t mandatory to have a 
login at this time, some post offices are 
requiring customers to login to view post-
age statement details, print hard copies and 
check account balances. Postal acceptance 
sites that are not on the system are not 
affected.

The Gateway provides access to the 
PostalOne! system, which provides mail-
ing information. 

Following are the steps to create a login 
on the Gateway:
1. Go to www.gateway.usps.com (or go 

to usps.com and look for the “Business 
Customer Gateway” link in the bottom 
right-hand corner). 

2. Register for access under “New Users.” 
(The user name must be at least six 
characters; the password must be at 
least 8 characters, one uppercase, one 
lowercase and 1 number). 

3. The first person to sign up will be 
prompted to become the Business Ser-
vice Administrator (BSA). This person 
is the key contact for the business. 

4. For “Profile Account Type,” click 
“Business.” 

5. Create a Company Profile. (The com-
pany name and address MUST match 
what is on file at the post office.)

6. Review your information and agree 
with the Privacy Act.

7. Select Manage Mailing Activity/(Post-
alOne!) from the Business Service list. 

You can add additional services and 
business locations later from the Gate-
way homepage.

8. After selecting your business location(s), 
click next. If everything is correct, on 
the next page click “Confirm.”
Congratulations! You’re now logged 

into the Business Customer Gateway. Now 
let’s look at your “Profile,” located either 
in the toolbar at top or under the red Pro-
file in the upper right-hand quadrant of 
the page. 

Your user profile displays your business 
location(s) including the CRIDs (Customer 
Registration IDs) as well as what services 
you have and whether those services have 
been approved. 

The CRID is a unique identifier that 
connects every Permit Number and Mailer 
ID issued. It’s critical to enter the business 
name and address for correct affiliation. 
You can use the CRID to add additional 
services or business locations.

The Business Services on the main 
Gateway page provide access to the Post-
alOne! System. “Accounts” is where to go 
for the balance and fees due for permits. 
The “Mail and Transport” section contains 
Postal Wizard, which provides an online 
avenue to submit an electronic postage 
statement. “Track & Report” is where 
you’ll find Mailing Reports. After click-
ing on “Mailing Reports” you can view 
transactions, pending postage statements, 
statement of ownership, mailing summary 
reports and other reports, such as Periodi-
cals transactions.

This should be enough information to 
set up an account on the Gateway. If you 
made it to the Gateway and are confused 
about what to do next, click on the Gate-
way Help Desk located under “Customer 
Service.” 

How to sign up for the Postal Gateway
without reading the 107-page manual

The Ada Evening News is offering a 
$150 reward for information leading to the 
arrest and conviction of whoever stole one 
of its newspaper racks. 

The rack was located in front of a local 
Main Street restaurant. 

Staff noticed it missing during Monday 
morning cash collections. Estimated cash 
in the machine was $12.

“Whether it’s stealing a whole rack or 
just individual newspapers out of a rack, 
it’s stealing,” said Ada Evening News Pub-
lisher Loné Beasley.

Circulation Manager Denise Gordon 
said the racks are emptied on a regular 
basis and rarely contain more than $10.

Thieves make off with Ada Evening News rack
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While InCopy is still very dependent 
upon InDesign – it works like an inter-
faced word processor for InDesign – this 
little program has become a powerful tool 
in its own right. 

InCopy makes it possible to have a 
layout view of your InDesign page as you 
type. 

It can spell check, make changes in 
real-time, override paragraph styles locally 
and create a visual workspace that’s easy 
on your eyes – such as white type on 
green. It’s really quite handy.

The program works in tandem with 
InDesign, but costs so much less; it’s per-
fect for editors and writers who would like 
to focus on their work independent of the 
designer’s larger layout.

Here’s how it works: the designer 
checks out part of the larger document 

to the InCopy user, who then types in the 
story. The program shows overflow and 
word count. 

Overflow can either be fixed on the 
spot or left for the designer to deal with. 
In addition, real-time notes can be sent 
between user and designer.

If your newspaper can only afford to 
upgrade one or two copies of Creative 
Suite but have several desktops that need 
access to the paper’s layout, this might be 
a workable solution.

If you’ve ever wondered what the User 
or Assignment palettes are for, this is it.

MORE INDESIGN TIPS & TRICKS: Newer 
versions of InDesign include a neat little 
feature – Separations Preview. 

This palette allows you to see whether 
colors will separate the way you want, as 
well as find out if the type on the page is 
showing up on all four color plates.

Just like Photoshop, you can click the 
eye on the left of a particular color to 
toggle on and off. 

The Ink Manager from the flyout menu 
shows if you have any spot colors that 
need to be set to CMYK.

Another useful command under the 
Type menu is Create Outlines. This is very 
useful if you’re having an issue with a font 
that won’t convert to PDF properly. It also 
works well when you want special type. 

Here’s a trick you might find useful: 
you can create outlines in conjunction with 
Text Wrap. Putting a short cutline inside 
artwork that’s wrapped can be frustrating 
since the cutline text doesn’t show up in 
your text box. 

Just select the text for your cutline, 
make sure it’s correct, and turn it into a 
piece of art with Type > Create Outline. 

Now your cutline won’t jump around 
inside text wrap.

Here are a couple of tips for renaming 
files. Whether it’s a thousand photos of 
the big game, a couple of screen shots or 
PDFs for upload to two different sites, the 
solutions are easily accessible.

To rename a few files, try this Mac tip: 
Click one time on the file to highlight it. 
Select the File menu or right-click and go 
down to Get Info (it’s just as easy to use 
Command + I). When the dialog box pops 
up, select the name and change it – the 
system won’t try to open the file while 
you’re renaming it.

For a bunch of files, you have a few 
options. If you already have Adobe Bridge 
(part of the Creative Suite in later edi-
tions), it’s perfect for this task. 

Open Bridge, navigate to your files, 
select the ones you’d like to rename and 
select Tools > Batch Rename from the 
menu above. You can type in a text name, 
start with a certain number and decide 
whether you want the files renamed in the 
same folder or saved to a different one.

If you don’t have Bridge, try a program 
called Renamer4Mac. For $25, you can do 
big batch renames. 

You’ll find it at http://renamer4mac.
com. It seems pricey, but it does what it 
does well and it’s easy to use.

You might also try Filewrangler 2.0; 
it’s a little less known but it’s also user-
friendly and costs a bit less at $15. 

You use it by dragging files to the pro-
gram’s main window, applying options 
and clicking “rename files.” I think you’ll 
find the “search and replace” function the 
first thing you’ll want to try.

For a few files on a PC, right-click on 
the file and select rename. If you want 
to name the files using the same root 
name, copy and paste it from one file to 
another.

For lots of files, try the program Bulk 
Rename Utility. You’ll find it at http://
www.bulkrenameutility.co.uk. This is a 
good program with tons of features and 
it’s my top pick. If you want even more 
choices, try:
• ReNamer, a simple, powerful utility – http://

den4b.com/downloads.php?project=ReNamer 
• Flexible ReNamer, has a preview feature that’s 

useful – http://download.cnet.com/Flexible-
Renamer/3000-2248_4-28799.html 
If you’re brave at heart, Automator on 

the Mac performs some of these tasks, but 
I think it’s worth a little money for these 
very handy and easy-to-use programs.

OPA Computer Consultant Wilma Melot’s column brought to you by the Oklahoma Advertising Network (OAN). 
For more information on the OAN program, contact Oklahoma Press Service at (405) 499-0020.

Contextual Menus
Contextual is a big word for a simple 

right click, but I’m surprised at how 
many people don’t use this handy fea-
ture. 

In all Adobe programs and in Quark, 
if you right click the working page at 
any time, regardless of the tool you’re 
using, you’ll get a pop-up window offer-
ing access to options available with that 
tool. 

Note: If your mouse only has one but-
ton, hold down the control key to turn it 
into a right-click.

Using Mac’s Keychain
Keychain is the utility on a Macin-

tosh that keeps track of passwords you 
use on websites and applications such 
as Mac Mail. 

You can find it under Hard Drive > 
Applications > Utility Folders.

Sometimes you run into problems 
with passwords when you rename the 
user on a machine. 

Many times you can solve those 
problems by simply deleting all the 
shortcuts from Keychain. 

Note: Each one of the keys is a user 
name and password for a different site 
or program, so be sure you know them 
before deleting them.

If that doesn’t work, look under User 
> Library > Keychains and remove the 
preferences folder. 

In extreme cases, you may have to 
remove the main log file in the Hard 
Disk > Library > Keychain folder. 

Turn any text to plain text
If text from your e-mail looks like 

garbage in the layout program, use this 
trick: copy the text into TextEdit on the 
Mac and select Format > Make Plain 
Text from the menu at the top. 

Many of the problems will go away.

Using InCopy with InDesign to improve workflow
computer notes

from the road
by WILMA MELOT

plugged IN

Software programs help users quickly rename files
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Lots of new front-page designs are 
grabbing readers’ attentions. Technology 
has made possible lots of neat innovations, 
with color photographs on smaller papers 
a key. 

It’s hard to look at these energetic 
papers and buy in to the pervasive despair 
and plummeting circulations and ad rev-
enues in the national newspaper industry. 
Journalism ain’t dead, but it sure is chang-
ing, as it always has as a child of technol-
ogy.

Then the publisher of The New York 
Times announces that that good – no-
longer-grey – lady will cease publication 
sometime in the future. I don’t even want 
to think about it, but if you read further 
he’s talking about charging for web con-
tent, etc.

Oklahoma City Journal Record Edi-
tor Ted Streuli, speaking to one of my 
classes about journalism leadership, talked 
about the changes in distribution of news. 
He believes there is a definite future 
for “niche” publications, which fits most 
Oklahoma newspapers. The JRs increased 
circulation and pay-for website are evi-
dence. 

I can live with that, and understand 
that the term news“paper” may be obso-
lete some day, but I’m not ready to quit 
spending my Sunday mornings on the 
back porch, drinking coffee and thumbing 
through the New York Times. I enjoy scan-
ning OPEN for this column, but don’t want 
to read the paper that way.

I also want to read books on paper, so I 
can mark the pages up and enjoy the feel 
of thought. Dinosaurs R Me, I guess. But 
Streuli hit another note that resounded:

“We’re all storytellers,” he said. Streuli 
can spin the yarns, for sure, based on many 
years of being a reporter and journalist. 

Reality check for newspapers in these 
days of wandering in a digital desert, try-
ing to find our way. Go back to the power 
of storytelling and the readers will follow. 
We get to tell other people’s stories, and 
the more wrinkles they have, the more 
stories they have. 

Technology may be the glamour girl, 
but it’s the content that counts.

Here are some reader-grabbing exam-

ples from your neighbors. Hats off to the 
Stillwater NewsPress, which teamed with 
an OSU prof for a front page feature on 
“What is Rosh Hashanah?” Next should be 
“What is Ramadan?” and a whole religious 
series on holidays. That promotes under-
standing and tolerance.

Talk to the working people. That’s what 
Ezra Mann did at the Pauls Valley Daily 
Democrat, interviewing the new chief 
nurse at the hospital. Teddye Snell at the 
Tahlequah Daily Press found two WWII 
vets to tell their stories marking VJ Day. 
These guys may not be here next year. 
What are you doing for your veterans? VJ 
Day passed almost unnoticed in our papers 
this year, as did Pearl Harbor. Will 9/11 
face a similar fate? 

Trend stories you should consider. 
Marsha Miller at The Ardmoreite writes 
about court-appointed advocates for chil-
dren. Head: “Kids with needs need special 
adults.” Her lead:

“When you hear or read about a child 
who is alone and in need – one who is hun-
gry and without basic necessities or a child 
suffering the torture of physical, mental or 
emotional abuse – where does your mind’s 
eye take you? Do you see a child living in 
a third world country?

“How about the slums or ghettos of a 
large metropolitan area? Or do you see 
the possibility that child lives right here in 
southern Oklahoma?”

Journalism Hall of Fame member Pam 
Henry, the pioneer Oklahoma woman 

broadcaster and March of Dimes icon, 
also spoke to my class, about change and 
technology and journalism. Her advice to 
young journalists: “Writing. Writing. Writ-
ing. Writing. That’s the most important 
skill there is in all of journalism.”

Good writing you need to read. Stigler 
News Sentinel, on a Doug Russell story 
about a cowboy’s death. Head: “Taps for a 
cavalryman.” His lead:

“There’s an empty saddle in the old 
corral.

“He was among the last true old-time 
cavalrymen in the U.S. Army, living 
through a time when a much less sophis-
ticated military was transitioning from 
horses and mules to automobiles; when 
a cavalryman rode to battle on horseback 
rather than in a helicopter or tank. But 
D.H. Jeffrey was more than a soldier. He 
was a lawman, a cattleman – and an inspi-
ration to others.”

Hard times in the state? Steven Jones of 
the Jenks Journal wrote about the extra 
demands at the local food bank. His lead: 

“They wait patiently, many times before 
the center even opens.

“Every Saturday in Jenks, and on Tues-
days in Glenpool, they line up and file 
through the local food banks to pick up 
their monthly allowance of food.

“Theirs are the faces of hunger in our 
community, and the Jenks Community 
Food Bank Inc. and Glenpool Outreach 
Center are among those standing in the 

gap to keep hunger at bay for as many as 
50 families.”

Great idea department: Cushing Citi-
zen runs a feature, written by Jim Perry, 
“Lunch with a Fifth Grader.” 

Perhaps the best football sections I’ve 
seen are at the Sequoyah County Times. 
New Sports Editor Mark Evans carries on 
a long tradition with a two-tabloid section 
this year. What I like most is that both 
sections feature linemen on the covers. 
Headline on the class 4A section: “Wall 
of Muscle.” 

Web page hint: Please list your phone 
number so people can find it without hav-
ing to search or click.

We’ve had a “spree” spree this month. 
I saw three papers—Shawnee News-Star, 
Seminole Producer and The Oklahoman 
– with the word in a front-page headline. 
Hmmm. I guess “if the spree fits, spew it.” 
For the record, the word probably comes 
from the Scottish spreath – cattle taken 
as booty, raid, plunder, from Irish Gaelic 
spreidh, from Latin praeda, for spoil and 
booty. –American Heritage Dictionary.

Here’s a salute to Lawrence Gibbs, the 
humorous, handlebar-mustached former 
editor at Stillwater and Perkins. He’s one 
of those who will always be remembered 
with a smile and a story about his humor. 
That’s the way we would all like to be 
remembered. I heard thunder the other day. 
I expect that was God laughing at one of 
Gibbs’ jokes.

Clark’s Critique
BY TERRY CLARK, Journalism Professor, 

University of Central Oklahoma
TClark@uco.edu

Return to great storytelling to keep readers’ interest

Grab readers with good writing, great headlines and big artwork as shown on the front pages of The Shawnee News-Star, The Okarche 
Chieftain, Stigler News-Sentinel and The Pawnee Chief.

Continued on Page 11
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Changes in the nomination process at 
the Oklahoma Journalism Hall of Fame 
have been announced by Dr. Terry M. 
Clark, director, at the University of Central 
Oklahoma.

“Because the new web page is still 
under construction, please consider mak-
ing nominations by e-mail,” Clark said. 
“The web page should be up and run-
ning this fall, but e-mail nominations will 
always be welcome.” 

The e-mail address for submissions is 
halloffame@uco.edu or tclark@uco.edu. 
Nominations also may be mailed to Okla-
homa Journalism Hall of Fame, Attn: Dr. 
Terry M. Clark, 100 N. University Dr., 
Edmond, OK 73034.

Deadline for nominations this year will 
be Dec. 15, Clark said, and the induction 
ceremonies will be May 13, 2011.

The selection committee will meet for 
a preview meeting in October to review 
the existing nominations and suggest other 
changes. 

Criteria for consideration are simple, 
Clark said. The person should have at 
least 10 years of journalism experience in 
Oklahoma, and/or be born in Oklahoma 
and have at least 10 years of journalism 
experience anywhere. People with public 
relations experience can be considered if 
they’ve worked the 10 years in traditional 
journalism. Long-time journalism teachers 
also have been honored. 

Each year the committee meets in Janu-

ary to select inductees. Those not selected 
are held over for consideration in the fol-
lowing years. Depending on the number 
and quality of the nominations each year, 
it is not uncommon for someone to be 
inducted a year or two after being nomi-
nated, Clark said.

“Most of the information is straight-
forward, but please explain to us in detail 
why you think the journalist should be 
honored,” he said. 
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ONLINE SPECIAL SECTIONS MICROSITES

HEAD ‘UP AWARDS: First Place, Shawnee 
News-Star, on a Johnna Ray story about 
a hydraulic leak closing Kickapoo Street. 
Headline by Andrew Adams:

Goo on the ‘Poo
Second place, tie,
Elk Citian, on a Derek Manning story 

about a rodeo family:
Rodeo genes
and Weatherford Daily News, on a 

Ryan Felder drug raid story:
Drug raid snuffed
Third place, Hooker Advance, Sheila 

Blankenship, about the Hooker Car Show:
Rev up the engines to rev up downtown 

Hooker
Honorable mentions: The Bigheart 

Times, “Wind farms back on the horizon”; 
Weatherford Daily News, on a Julie Hard-
ing series on liquor laws: “No happy hour 
here.” Also the heads mentioned from 
Ardmore and Sallisaw.

How to get readers’ attention? Spe-
cific details in a headline will do it. The 
Valliant Leader on a con job: “‘Worth-
less’ $3,995.95 Check Mailed to Millerton 
Woman.”

Headline hint: Don’t use italics for 
main headlines. I used to do this for vari-
ety. Makes them hard to read.

A new art service

& sales resource  

tailored to the 

newspaper industry

with flexible pricing options. 

creativeoutlet.com
800.245.9278 | create@multiad.com

Sign up today for a free account and you’ll receive 

a collection of 25 complimentary art pieces!
Offer expires October 31, 2010

Journalism Hall of Fame seeking nominations

Continued from Page 10

Clark’s Critique
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CONGRATULATIONS TO THE JULY 2010 CONTEST WINNERS

Thank you for continued support of “Share The Warmth”
Read the Winning Columns and Editorials on the OPA website: www.OkPress.com (Under Contests)

Enter and Win a 
$100 Check from ONG!
1. Each month, send a tear sheet or photocopy of 

your best column and/or editorial to ONG Contest, 
c/o OPA, 3601 N. Lincoln Blvd., Oklahoma City, OK 
73105-5499.

2. Include the author’s name, name of publication, 
date of publication and category entered (column 
or editorial).

3. Only ONE editorial and/or ONE column per writer 
per month will be accepted.

4. All entries for the previous month must be at the 
OPA office by the 15th of the current month.

5. Winning entries will be reproduced on the OPA 
website at www.OkPress.com.

Entries must have been previously published. 
Contest open to all OPA member newspapers.

Although Oklahoma Natural Gas Company selects 
representative contest winners’ work for use in this monthly 
ad, the views expressed in winning columns and editorials 
are those of the writers and don’t necessarily reflect the 
Company’s opinions.

JULY 2010 COLUMN WINNER KAREN BRADY, CHICKASHA EXPRESS-STAR

Nothing was wrong with Wonder Woman
I recently read that DC Comics has decided, with doubtful wisdom, to “update” Wonder 

Woman’s iconic costume. 
The ravishing, muscular, raven-haired beauty brandishing bracelets of steel will no longer be 

(barely) clad in her familiar red and gold bustier and star-spangled short shorts. 
She has been reduced to a mere mortal in (yawn) full-length black leggings. 
Leggings? Since when did super heroes start wearing leggings? Pair those with her new black 

leather jacket and she looks more like a baby-faced motorcycle mama wannabe. 
Gone are her ebony curls waving in the wind. Replaced with lanky locks that hang limply 

around her too-sweet, too-young face. 
She reminds me more of a Speed Racer character than the Wonder Woman I grew up with. 

Gone are her red knee-high boots which have been replaced with booties. 
Booties? How is a super hero going to kick butt wearing a pair of booties? 
Gone is her gold-plated bustier, the object of many a young man’s dreams. Only to be replaced 

by a (yawn) t-shirt. 
What’s next? A berka? 
Super heroes are supposed to be sexy; that’s part of their appeal. It’s what makes them stand 

out from the crowd. Their spectacular good looks, muscular bodies dressed in skin-tight costumes 
that don’t get in the way when they are fighting off dastardly foes are a huge part of their per-
sona. 

Superman is sexy in his blue tights and flowing red cape, as is Batman in his mask and, again, 
tights and flowing cape. You won’t see either one sporting a pair of leggings! 

With these changes, DC has done away with the Wonder Woman we have known and loved. 
There’s nothing to wonder about this woman. 

And, if that’s not enough, DC Comics has even taken away Wonder Woman’s history. 
No longer can she be proud of her Amazon heritage because they destroyed the island where 

she was raised by her mother and sisters. Geez, is nothing sacred? 
I am not afraid of change, indeed, I welcome it and the new opportunities it brings. 
But, some things don’t need to be changed. Some things are fine just the way they are. 
And Wonder Woman was pretty fine just the way she was.

Column:
KAREN
BRADY

Chickasha Express-Star

Editorial:
KIM

BENEDICT
The Ardmoreite
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